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Who to call

Questions, comments or problems should be reported to:
U.S. Forest Service: your forest or zone check cruiser.
Other agencies: your local measurements specialist.
FMSC contact: Matt Oberle, 970.295.5752,

moberle at fs dot fed dot us

Introduction

FStallyMeter is a Windows CE x|
alternative to the TM-100, a popular

; ; FStallyMeter
electronic handheld tally device no e
longer in active production. FStallyMeter
is a joint project of the Forest U5, Forest Service

Management Service Center and the Reretlheres et S os G,
San Dimas Technology & Development Fart Callins, CO

v fz fed usdfmac/measured

Center.
San Dimas Technology & D evelopment Center,
. . San Dimas, CA
Like FScruiser, FStallyMeter has been v fz fed LsdengAtechdesAsdtde him

designed to be small, fast, stable,
intuitive and very easy to customize.
While FStallyMeter is ideally suited to
traditional tree tallying, its generic
design allows it to be customized and used for a variety of data collection
applications such as wildlife, rangeland, forest fuels, and tree nursery
inventories. Unlike FScruiser, FStallyMeter is not intended to provide the
comprehensive timber cruising data needed by the Cruise Processing
Program.

Up to 20 populations may be defined, each of which can be assigned a
user-defined data table for sample collection. Populations can be set up to
share the same data table, or each population could be assigned its own
unique table. Data tables currently allow up to six user-defined data fields.
If sample selection is desired, each population is assigned a sampling
method (random, blocked, adjusted or systematic) and a sampling
frequency if applicable. 3P sampling will be available in later versions.
Once a tally has been customized, it can be saved as a “template” file for
future use in similar tally projects. Data is exported as CSV-formatted files
which are easily opened by PC spreadsheet applications.



FStallyMeter will run on any Windows CE data recorder or PDA, allowing
field units to purchase hardware that fits their local environmental
conditions and budgets. A PC version of FStallyMeter is also available for
evaluation and training.

Installation

In addition to the executable program file (FStallyMeter.exe), you will need
a template file that contains the specifications for the tally. The template
file default.tal contains a simple skeleton for a four population, two unit
tally, along with a single data table for recording sample tree data.
Creating a new tally template file is discussed in the Utilities section.
Installation to a data recorder is relatively easy: Download the appropriate
FStallyMeter zip file from the internet and unzip it into a folder on your PC.
Each zip file will contain a file called install.txt where you will receive short,
simple instructions on where to place the other files onto your particular
data recorder model. Using ActiveSync or a storage card, transfer the
unzipped files to the specified locations on your data recorder. The PC
version of FStallyMeter and its associated files can be placed and run from
anywhere on your PC’s hard drive.

Filing Strategies and Data Safety

Since all of the setup, tally, and measurement data are contained in a
single file, a data recorder can contain many independent tallies. Most
likely, much of this setup would be done on a PC in the office. The tally file
would then be given to the field crews for download to the data recorder.
As with any data collection effort or PC use, a backup strategy is an
integral part of the system. Because the tally files will generally exist on a
PC as well as being downloaded to the data recorder, it is important that
care be taken not to inadvertently overwrite one file with another. For
example, rather than overwrite the PC file with the data recorder file or
vice versa, rename either the PC file or the data recorder file and then
copy over the newer file.

It is also important to keep your tally files on some type of non-volatile
storage in your data recorder for data safety. Non-volatile storage
preserves its contents even if the device is powered off, the battery runs
down or a hard reset is performed. Examples of removable non-volatile
storage are compact flash (CF), secure digital (SD), and PCMCIA (also
known as PC) cards. Currently there are two different technologies used
for CF and SD cards: MLC (Multi-Level Cell) and binary. The use of binary
cards is highly recommended because they are considered commercial
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grade and are faster and more reliable than the cheaper MLC-based
cards.

Most data recorders also have built-in non-volatile storage which is
identified differently depending on the data recorder make and model. For
example, Dell Axims refer to it as “Built-in Storage”, while it is called “iPAQ
File Store” on HP iPAQs. Other folders on data recorders such as “My
Documents” exist only in memory which is volatile, meaning the contents
may be gone after a power loss or hard reset. Refer to you data recorder’s
user manual to determine the safest place to store your tally data.

Periodically backing up the cruise files to a server is a good idea;
Q however, never use FScruiser to open a cruise file residing on a

server. To work with a cruise file stored on a server, copy it to a
folder on the PC’s hard drive and open it from there.

Start the Program

Use any of the common methods to start the program such as navigating
to the folder where the program is stored and double clicking, or by
creating a shortcut to the program. When

x|| the program starts, you will see the
Select Taly Ele | | opening screen. Notice the Setup, Edit

Data, Tally and Utilities buttons are

unavailable. They will become available

after a tally file has been selected. The

Eclt Data Untally button becomes available only
Tally after you have begun tallying.

Setup

Wtilities:

About [ rtally |

Help

LL A




Look jri: | 4 FStallMster

~| « @ E-

2

Select a file by
choosing the Select

Tally File button to

| 1z004TallyFiles
12005 TallyFiles
[:I Docurnents

. Default,kal

navigate to and
select the file.

File name: |Default.ta|

Open |

Files of type: | Tally Files [*.tal]

j Cancel |

4

i, FStallyMeter |

Select Tially Eile | IDefauIt.taI

Setup

Edit Data
Tally

Utilities

About

_sew |
_Edtdsa |
_ = |
_ Ui |
| Wtally |
| »

Help

Notice that now the four main buttons are
now available, but the Select Tally File
button is unavailable. To choose a
different tally file, you must exit and restart
the program.

The Setup, Edit Data, Tally, and Utility
buttons represent the four main areas of
the program.



Setup

To setup a tally, you will need to specify the number of units, the number
of populations, and the data table you will use to record information about
the sample. All of this is done within the Setup section of the program.
The number of units and the number of populations are read from the
selected tally file and are displayed on the Setup screen. You can change
the number of units by selecting the Change button. It is important to
understand that if you reduce the number of units and have collected
data, you may lose data.

The Save Data pulldown control allows e T
you to select how often data is saved.

Saving data every (1) tally is the safest Mgyl dalss 2| Ll |
option and doesn’t appear to slow tallying

D Murnber of Populations: 4
significantly, even on slower handhelds.
Setup Data Tables |
Checkboxes provide three additional Setup Papulations |
Optlons’ whether or not to: Save data every ISD vl talliez.
1. Allow the computer to make a % Sound

sound with each hit (sample).

2. Dynamically display each
population’s current counts on the
tally buttons.

3. Display the last hit (sample)
number on the tally window. If
displayed, this number can be changed by the user (for example you
could enter a 50 to start numbering at 51). This option requires two
conditions: a) Each population must use the same data table, and b)
The data table must have a field named ‘Num’. More information on
special data field names such as ‘Num’ is provided in the Setup Data
Tables section.

[+ Counts on Buttons

v Show Last Hit Mumber




Setup Data Tables

Any type of information can be collected for the selected samples.
However, in order for the program to know what type of data (information)

Setup Data Tables x|

Existing T ables: ITrees j

Delete this Table |
Edit thiz Table |
Create Mew T able |

you wish to collect, you must first “create”
and/or “define” a data table. To do this, hit
the Setup Data Tables button to pop up
the following screen:

From this screen, you can delete a table
definition, edit an existing definition, or
create a new definition.

For example, the default tally file comes with a tree table defined. If you
hit the Edit This Table button, you will see the following screen:

T
Table Mame: ITIEES

Columnz in T able, seperated by commas:
Unit, Murn, Label, DEH. HT, Def

“ou can defing up to B columnz.

"Unit", "Mum"’, and "Label" are special
calumn names. [F used, they will
automatically fill the sample's:

Unit: unit number
MHurn: zample nurmber
Label: population label

Here, you can edit the names of the
column you would like to appear in your
table; names must be comma separated
without spaces. In this example, 6
columns have been entered as a comma
separated list of values. You can change
the columns to anything you choose to
collect sample data abouit.



Define Columns
Table Mame: I

Columng in T able, seperated by conmmas:

X|

You can define up to B columns,

"Unit", "Mum", and "Label" are special
column namesz. I uzed, they will
automatically fill the zample's:

Unit: unit number

Mum: zample number

Label: population label

If you want to create a new table to collect
your information, hit the Create A New
Table button to pop up the following
screen:

This screen is essentially the same, with
the exception that you can enter the name
for the table as well as the desired column
names. Then, when you define a
population (discussed later) and specify
which table is to be used for data
collection, that particular table will pop up
for each sample hit and allow you to add a
new record to the table. A single table
can be associated with multiple
populations, or you can define a different
table for each population.

If the previously defined tree table was linked to a population and a sample

hit for that population occurred,

Editing record 3 of 3 from Trees
Unit |un1
M |4

x|

Label |PP

DEH |12.1

HT IEB

E

Def

M avigation:
] < > >

Mew I Deletel

you would see the following dialog appear:

This screen displays one record from the
user defined Trees table. To record data
for the sample, fill in the fields and hit the
OK button.

If you name one of your fields ‘Unit’, the
sample’s unit number will automatically
appear in the Unit field. Similarly, a field
named ‘Label’ will automatically enter the
sample’s population label, and a field
named ‘Num’ will automatically enter the
sample’s number.

Currently, you can display only a
maximum of 6 fields from the table.



Setup Populations

Counting and sampling typically takes place by category or group; this
grouping of items defines a population. Examples of a population might
be: all of the Douglas-Fir trees or all

A 2|x|| Ponderosa Pine larger than 127, or
Edtingrecord 1 of 2fom all of the seedlings in a nursery bed,
key i or even a!l of the cans of beans on a
Label [P grocery alsle: To define a _
population, hit the Setup Populations
Dese [Population 1 button. This will pop up a form that
Meth |7 allows you to define your population:
Fieq [10 Notice that the first line tells you that «- - - { Formatted: Bulets and Numbering |
you are editing the first population
DatTatle |Trees (record 1) definition out of a total of 4
Navigation in the Tally table. The tally table
ﬂjjﬂ contains not only the specifics about
— the population, but also the counts
—l—l and hits by unit; see the outputs
section below to see the structure of

this data. In order to describe the
population, six pieces of information need to be specified: \
« The first field, Key, is the hotkey that will be used for this <~ | Formatted: Bullets and Numbering |
population; hit this key to increment the count for this group. The
hotkey number will be displayed on the tally keypad in brackets.
For example, the hotkey for this population will be displayed as [1].
Each population must be assigned a unique key. The key is
required even if tallying is going to be done by tapping tally buttons
on a data recorder’s touchscreen.
e The second is a Label field which will be used to “label” the key on
the optional pop up tally keypad; keep it short so that it can be
displayed on the key.
¢ A longer description can be entered in the Desc field.
e The sampling method in the Meth field specifies if and how
sampling will take place. Currently, if you simply wish to tally and
do not want or need samples selected, you can leave this field
blank. If however, you do wish to have samples selected, you can
choose from four sampling methods: Random, Systematic,
Adjusted, or Blocked. This is done by entering an ‘R’, ‘'S’, ‘A’ or ‘B’.
A detailed description of these sampling methods can be found in
Appendix A.




e If sampling is requested, you will need to enter the desired
frequency in the Freq field. Either enter the frequency (as a whole
number X), for example as 1 in X, or enter the decimal percent
such as 0.10 for a 10 % sampling frequency. Again, the details of
the four sampling methods are available in Appendix A.

¢ And finally, if you would like to record data about the samples, you
can specify a user defined table that will pop up for sample trees.

Use the navigation keys in the Navigation group box to move through the
defined populations. Hit the << button to go to the first record, the < button
to move to the previous record, the > button to move to the next record,
and the >> button to move to the last record. In addition, hit the New
button to create a new blank record (that needs to be edited), and the
Delete button to remove the current record. These population definitions
will be saved into the Tally table.

Units

In a forestry context, tally counts are typically maintained by a physical
piece of land or unit. The same populations exist on each and every unit,
so they only need to be defined once. However, the tallies are maintained
by unit. The data structure used to track tallies is contained in the one
table called Tally. You have already seen some of the information in this
table when you defined your
x| populations. So there is one row in this
table for each population. In addition,
for each unit you define, two columns

Pleaze enter the nurmber aof units far this tally.

W RMIMG: If you reduce the number of units will be tacked onto th|s tab|e one
and have collected data, you may loose data. !
column to track the counts, and the
Numberof Uit [/ other to track the hits. If you do not

want to track counts by unit, then simply
define a single unit (there must be at
least one unit).

To add these columns to the tally table,
simply hit the Change button on the
Setup Screen to pop up the following
screen:

Enter the number of units you have and accept by hitting OK. To tally by
unit, use the unit pull down list on the Tally Window to select your current
unit; this will tally into the same unit columns in the Tally table.



Edit Data

Selecting the Edit Data button from the main dialog window displays a
screen where you are instructed to select which table to edit. Select the

E— x|
Editing record 3 of 3 from Trees
Unit |nn1
MNum |4
Label IPP
DEH |12.1
HT |EB
Def 19
M avigation:
<] 2] 2
New | Delete | Ok I
Tally

desired table and click the Edit this
Table button: this pops up the following
form which displays your last measure
record. Here you may add or delete a
record, or navigate to any measure
record and edit its data.

Tallying is very straightforward. Tapping the Tally button on the main
dialog will pop up the Tally window containing tally buttons. There will be

Xl
Urnit; 001 = | DF Mum: IBE

FP DF

] [2]

C:26 C:29
b4:1 I4:4
LP WiF
[Z] [4]

C:14 C:25
b:3 bd: ¥

one tally button created for each
population that you have defined. Each
button will display the populations’ label
and its hot key within square-brackets
below it. If Counts on Buttons was
checked on the Setup window, each
population’s count and measures will be
displayed on their respective buttons
(shown), and will be updated as tallying
progresses.

Similarly, if Show Last Hit Number was
checked on the Setup window, an edit
box labeled ‘Num’ will appear in the

upper, right corner of the Tally window.

This hit number is the largest value that exists in the data table’s ‘Num’
field for that unit, and increments for each hit. It is not simply the sum of
the measure records. In this example, although the sum of the measure
recordsis 1 + 4 + 3 + 7 for a total of 15, Num is 65. This is because the
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user entered ‘50’ into the Num box before tallying, and the fifteen measure
records were assigned the values 51 through 65 in the ‘Num’ field of the
data table.

Tallying can be accomplished by first selecting the appropriate unit, then
pressing the appropriate hot key using a keyboard or keypad, or by
clicking (tapping) on the button itself. The status text at the top of the
window will let you know which population was last tallied and if it was a
hit.

Hit one of the hot keys assigned to a population to increment the count for
that population.

Keep hitting keys as you tally, and fill in any sample data as the screen
pops up. If sampling was requested, the sample will be drawn and the
results of the selection will also be displayed. If a data table was defined
and linked to the population, and if this is a sample, a data entry form will
pop up to allow you to record sample information.

11



Untally

From time to time you may accidentally double tally or mis-tally (tally the
wrong population) and need to “untally” it. This can be done by closing the
tally dialog and tapping the Untally button on the main dialog which opens
the Untally dialog. The Untally dialog displays a running list of the last ten
tallies, with the most recent tally at the bottom of the list. Each tally in the
list shows its Unit, Label, and whether it was a count “C” or measure “M”.
To untally a record, tap it once to select it and then tap the Untally
Selection button. The item will be replaced with the line —untallied--.
Operationally, if a count is untallied, the count for that unit and population
is simply decremented. However, if a measure record is untallied, both the
count and hit for that unit and population are decremented and the
corresponding data record is deleted. Below are three screenshots of
the Untally dialog showing this sequence with a count record.

|
most recent most recent | -untalied--
Whtally Selection | Untally Selection | W htally Selection
o |
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Utilities
The Utilities button takes you to a Utilities window with five buttons:

¢ And last but not least, how do you get at the data you entered into - { peteted: <sp>

tally meter, particularly the sample information? The Export Data
button will dump the entire contents of your tally to an ASCII text file.
The data is stored in an efficient and compact open source format of
MetaKit (a lightweight database library). The name of that text file
will be the same as your tally file with a .csv appended to it. Thisis a
comma-separated values formatted file. If you have Excel installed,
then in all likelihood, it will be the default program associated with
the .csv extension. Double clicking on the file will open it in Excel in
a neatly column formatted data table. You can, however, still open it
with any text editor that you have lying around. Exporting data is
currently available only in the PC version of FStallyMeter, so you will
need to transfer your tally file (.tal) to your PC and use the PC
version of FStallyMeter to export.

e The Reset Counters button sets all of the counts to zero and clears
out the history list that is displayed in the Untally box. Use this button
with caution, because the data it deletes will be gone permanently.
A confirmation window will ask you if you are sure.

e The Clear Data Tables button
wikies = does just that, it deletes all the
* records in all of the data tables
that have been defined.

_ EwotData | e The Clear Message Log
Flcseh G | button removes all of the

records from the Message Log
Clear Data T ables | table.
Clear Message Lc-g| ¢ Finally, the Create Template

Create Template | button pops up a window

where you may type in the

tMessage Log containg B records name of a temp|ate ta"y file
you wish to create from the
currently loaded tally. The new

template file will contain all of
the setup information from the
original tally but the counts will
be zero and the data files will
be empty.
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Let's take a look at a typical output from the standard default tally; see the
sample output in Appendix 1. The output contains blocks of tabular data,
with each block beginning with some descriptive information. The 1% line
of each block begins with the block name in square brackets (i.e. [Tally]).
The 2" line of the block is an internally used data structure that can be
ignored. The 3" line is a comma separated list of column names for the
data in the table. This is followed by a comma separated list of the tabular
data. The Globals table contains data that is used internally by the
program. The data of most interest to the user is in the Tally table, and any
tables defined during setup (i.e. in this example, Trees).

For the Tally table, the first six fields are the ones that the user specifies
during the customization of the setup (i.e. the population name, hot key,
sampling method and frequency, etc.). The rest of the columns in this
table represent the count and hit data by unit, and have the names
UnnnXXXX, where nnn is the unit number, and XXXX is either Count or
Hit.

In this example, a single table, Trees, has been defined. When samples
were encountered during the tally, a new record was created in this table
and the user was prompted to enter the sample data. The columns in this
table are the data attributes that the user defined. The column titles and
the recorded data are displayed. If there were additional sample data
tables defined, they would follow as additional blocks of data.

Note that the Messagelog table can be used as an audit tool. The
Message Log Table records events such as if and when: The tally file is
opened or closed, a new version of FStallyMeter is detected, anything was
untallied, a data record or population was deleted, data was exported, a
template was created, data tables were cleared, counters were reset and if
the message log itself was cleared.
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Future Enhancements
While FStallyMeter was originally designed as a substitute for the TM100,
the greater processing power of Windows CE based handhelds, coupled
with the relative ease of programming gives us opportunities to enhance
its functionality. The following enhancements are planned for future
releases of FStallyMeter:
e Present data in a grid (table) rather than a forms-based dialog. This
will allow nearly unlimited data fields.
e Add 3P sampling.
e Improve the speed of program execution (which affects how fast you
can tally).

User feedback will be used to guide future development.
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Appendix 1: Sample Output from Export.
Viewed in a text editor:

[Globals]

Globals[Block:S,Key:S,Value:S]

Block, Key, Value

System, Version, 1.2_Beta

System, Password,

Tally, Desc, Initial Tally Configuration

Tally, NumUnits, 2

Tally, CurUnit, 2

Tally, TablesDefined, Trees

System, Sound, Y

System, ShowCountsOnButtons, Y

System, ShowNumBox, Y

System, Savelnterval, 1

[Tally]
Tally[Key:S,Label:S,Desc:S,Meth:S,Freq:F,DatTable:S,U001Count:L,U001Hit:L,U002Count:L,U002Hit:L]
Key, Label, Desc, Meth, Freq, DatTable, U001Count, U0O01Hit, U002Count, UOO2Hit

1, PP, Ponderosa Pine, B, 8, Trees, 24,1, 8,1

2, DF, Douglas-fir, B, 5, Trees, 25, 4, 3, 1

3, LP, Lodgepole Pine, B, 10, Trees, 9, 2,17, 1

4, WF, White Fir Pulp, B, 5, Trees, 20, 6, 3, 2

[Trees]

Trees[Unit:S,Num:S,Label:S,DBH:S,HT:S,Def:S]

Unit, Num, Label, DBH, HT, Def

001, 1, DF, 12, 60, 10

001, 4, PP, 12.1, 68, 15

001, 5, DF, 12, 60, 5

002, 1, DF, 8.7, 41, 15

002, 2, WF, 10.9, 71, 45

002, 3, WF, 9.3, 39, 50

002, 4, LP, 12.8, 78, 15

001, 6, WF, 9.8, 54, 10

001, 7, WF, 23.6, 97, 15

002, 5, PP, 21.3, 102, 25

[MessagelLog]

MessageLog[MsgNum:S,Msg:S,Date:S,Time:S,Level:S,Note:S]

MsgNum, Msg, Date, Time, Level, Note

, Message Log Cleared, 06/26/2003, 10:21, A,

, Tally File Closed, 06/26/2003, 10:21, |,

, Tally File Opened, 06/26/2003, 10:21, |, \Storage Card\Default.tal

, Population record deleted, 06/26/2003, 10:23, A, Record 4 from the Tally table: 5 AF* Alpine Fir Pulp® R" 20" Trees
, Data record deleted while in Edit Data, 06/26/2003, 10:24, A, Record 8 from the Trees table: 001" 6" AF~ 14.0" 76" 50
, Untally, 06/26/2003, 10:24, A, 002 PP M Data deleted from Trees table: 002 5 PP 16.4 69 5
, Untally, 06/26/2003, 10:25, A, 001 LP C

, Tally File Opened, Thu Jul 10 11:25:23 2003, , |, C:\Projects\FStallyMeter\Release\Default.tal
, Data Exported, Thu Jul 10 11:28:30 2003, , A, C:\Projects\FStallyMeter\Release\Default.tal
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Appendix 1: Sample Output from Export (continued).
Viewed in Microsoft Excel

A | E | C [u] E F | G | H | 1 | J K|

| 1 |[Globals]
| 2 |Globals[Block:S | KeyS Walue:5]
| % |Block Key Walue
| 4 | System Wersion 1.2_BEeta
| & |Sustem Fazzword
| & | Tally Oesc Initial Tally Configuration
| 7 | Tally FumUnits 2
| & |Tally Curlinit z
|9 | Tally TablesDefined Trees
| 10| System Sound ks
| 1| System ShowCountsOnButtons ks
| 12| System ShowhumBo: i
| 13 | System Sawelnterval 1
14 [[Tally]
| 15 | Tally[key.S Labels Dezc:S MethiS | FreqF DratT able:t UO01Coun UOOIHIEL | U002Cour U002HitL]
| 16 |Key Label Oesc Meth Freq DlatTable| UOMCour UO0THIE | U002Cou LO02Hik
| 17| 1 PP FPonderoza Pine E 8 Trees 24 1 g 1
|18 | 2 OF Diouglas-fir E 5 Trees 25 4 3 1
|13 3 LP Lodgepale Fine E 0] Trees 3 2 17 1
| 20 4 WwF ‘white Fir Pulp E 5 Trees 20 [ 3 2
| 21 |[Trees]
|22 | Trees[Unit:S Mum:S Label:S DEHS  HT:S Dek5]
| 23 | Unit Mum Label DEH HT Dt
| 24 | 1 1 OF 12 Bl 1
| 28 | 1 4 PP 121 = 15
| 26 | 1 5 OF 12 E0 5
| 27 | 2 1 OF ar 41 15
| 28 | z 2 WF 0.3 Fil 45
| 29 | 2 3 WF a3 28 50
| 30 | 2 4 LFP 12.8 T8 15
|31 1 E WF 3.8 54 0
| 32 | 1 T WF 236 a7 15
| 33 | 2 5 PP 273 10z 25
| 34 |[Messagelog]
| 35 |Messagelog[M: MzgS [mELER= Times LevelS  Mote:S]
| 36 | M=ghlum M=zg Date Time Lewvel Rlote
| 37 | Message Log Cleared OB{2EA2003 101 A
| 28 | Tally File Clozed DEf2EAZ003 1021 |
| 39 Tally File Opened OB{2EA2003 101 | vStorage CardiDefault.kal
| 40 | Population record deleted OB{26A2003 1023 A Fiecord 4 from the Tally table: 5* 4F * Alpine Fir Pulp® B 20 Trees
| 4| Diata record deleted while in Edit Data | D8/ZE{2003 10:24 A Fecord & from the Trees table: 001" B AF™ 14.0° 75" 50
| 42 | Lintally DE{2EA2003 1024 A 002 PP M Data deleted from Trees table: 002 5 PP 16.4 636
| 43 | Lintally OEF2EA2003 1026 A o LP
| 44 | Tally File Opened Thu Jul 10 11:25:23 2003 | C:FrojectsiFStallyMetenReleaserDefault.tal

45 DOlata Exparted Thu Jul 10 11:28:30 2003 =) C:AProjectziFStallyMetenRelzaserDefault.tal

b
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Appendix 2: Sampling Methods

Introduction

FS Tally Meter provides five sampling methods: Complete, Random,
Blocked, Adjusted and Systematic. When setting up a new population you
would select these methods by entering either “C”, “R”, “B”, “A” or “S” into
the Meth field of the population form. The Complete sampling method
assumes a 100% frequency and ignores the Freq field. The remaining four
methods do require a numeric frequency in the Freq field, although they
each use the frequency in different ways as described below.

Pseudo Random Number Algorithm

Random, Blocked and Adjusted sampling methods require a random
number for sample selection. These three methods draw a pseudo random
number using the Mersenne Twister algorithm, which is both fast and has a
very long period.

Complete Sampling
Complete sampling assumes every tally is a sample, or 100% sampling.

Random Sampling

Pure random sampling has typically been used in timber cruising. Random
sampling is performed as a series of Bernoulli trials, with a random draw for
each tally tree, resulting in each tree having a desired probability of
selection. Random numbers being as they are, you could have long
stretches where you might get no hits, then have several in a row. In the
long run, however, you will achieve the desired frequency.

Blocked Sampling

A blocked sampling scheme results in exact frequency of selection within a
given block. FS Tally Meter’s block sampling method is two tiered. For a
single tiered block where a block the size of the frequency (say 10 for a
1:10) is established, one individual being randomly drawn out of it would
guarantee the exact frequency is met. Only trouble with this is that a
careful observer might note when the block starts and when it stops. Then
when a sample occurs within a block, you know that you will not have
another sample for the remainder of the block. A two tiered sampling
scheme is less predictable. In this scheme, a large block of numbers (say
10 times the frequency, or 100 for a 1:10) is allocated, then a sub block
that is some multiple of the frequency (say 20 for a 1:10) is used to group
numbers out of the total block list, and each sub block has one individual
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randomly picked. In this example, there would be 5 samples picked, one in
each group of twenty, this leaves 5 additional samples to be picked; these
remaining samples are randomly dispersed through the entire block. The
longest you would ever go without a sample is 38 in this example, or two
times the sub block size -2.

Adjusted Sampling

Adjusted sampling modifies the probability of sample selection based on
how far the observed frequency is from the desired frequency. The further
the observed is from desired, the greater the modification.

Systematic Sampling

Systematic sampling means if you assign a frequency of 10 for a 1:10,
every tenth tree will be a hit. Obviously it is difficult to avoid introducing bias
of sample selection with this sampling method.
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Appendix 3: Calculating Tree Volumes Using the Volume
Functions for Excel

If tree species, DBH and total height data is being collected volumes can
be calculated relatively easily using the Forest Management Service
Center’s Volume Functions for Excel. The following is a simple example of
how tree data collected with FStallyMeter could be used to calculate
volumes in Microsoft Excel:

1. Download the Volume Excel Functions from
http://www.fs.fed.us/fmsc/measure/volume/software.php, read the
accompanying documentation and load the functions.

2. Open the desired tally file (default.tal will be used for this example)
and export it on your PC.

3. Open the newly exported CSV file using Excel.

4. Use File->Save As to save the file as a Microsoft Excel Workbook

(XLS).

R I=E
@ File Edit Wiew Insert Format  Tools Data wWindow  Help -8 X
Dedaadt &l vy - @E-2 B0 TAT

A10 - F Lnit
A | 8 | ¢ | b | B | E | 6T

B 3 Pop3 FPopulatior R 5 Trees o
B 4 Popd Papulatior B 10 Trees _|
| 8 [[Trees]

9 | Trees[Unit: Murm: S Label:s  DBH:S HT:5 Def 5]

|10 |Unit Murm Label DEH HT Def
ERE 1 1 Pop3 12 B0 8
| 12 | 1 2 Paop2 116 58 a
iz 1 3 Paop2 2 41 5
| 14 | 1 4 Popd s 73 15
i 1 5 Fop3 1253 GG 10
| 16 | 1 E Paoph 9 G i
] 1 7 Popd 18] 512] 16
| 18 | 1 8 Popd 14.7 7B 12
| 19 ] 1 9 Popd 18.2 2 5
| 20 | 1 10 FPaopd 11.8 B2 a
21 1 11 Paopl 12 A4 18
| 22 |[Messagelog] -
M« b wl\Default / | <] | _>_IJ'J
Ready Sum=1009.8 i
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5. Use Insert->Worksheet to insert a new worksheet. Rename the
new worksheet Tree Data.

6. Go back to the original worksheet (it will be named after your file
Default) and copy the data, with headings, and paste it onto your
new Tree Data worksheet.

EA Microsoft Excel - Default.xls E =10l x|
@ File Edit Wew Insert Format Tools Data  Window  Help -8 X
Dedoan ERY | {BE-F o-@=-4 bk 2~ 2
G17 - e
s o [FENE G [
1 |Unit | Num | Label | DBH  HT | Def =
(2] 1 1|PP 12 G0 g
i 2|FP 116 58 a
4] 1 3 DF 91 M ]
Gl 1 4 PF 238 73] 15
B 1 S|FF 123 B& 10
7| 1 & DF 9] 38| 15
8] 1 7 OF 131 B9 18
B 1 g8 DF 147 76 12 b
o) 1 3PP 192 72 5
11 1 10 OF 1.8 B2 a
2 11 PP 121 B4 18
ke .
|11 4 ¢ n[s Default } Tree Data 4] | _r_]_l_J
Ready A

7. Inthe Tree Data worksheet, add a column heading called Volume
Equation Numbers.

8. For each tree record, enter the appropriate volume equation
number for the species (Label) using Appendix B of the Volume
Estimator Library Excel Functions document for reference. Instead
of typing the equation numbers, you could copy them from the
Appendix and paste them straight into the appropriate Excel cell.
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E3 Microsoft Excel - Default.xls

~=lol =]

@ File Edit “ew Insert Format Tools Data  Window Help -5 X

DEHaSR SRV IB2E-< - @ =-8lE 26 2
H16 - &
Al B[ C[DTETF] G R [ (7

1 |Unit  Mum | Label DEH  HT  Def “aolume Equation Mumbers

B 1/PP 12 B0 8 300DVEW122

El 2 PP 116 58 0 300DVEW12Z

R 3DF 9.1 41 & 30IDVEW202 |

(5] 1 4|PP 239 73| 15 s00DVEW122

6| 1 &|PP 123 B6 10/ 3I00DVEW122

= K G DF 9 39 15 30IDVEWI0Z |

8| 1 7 DF 131 B3 16 301DVEW20Z |

9| 1 8 DF 147 76 12| 301DVEW20Z |

ERI 9 PP 192/ 72 5 300DVEWIZZ

11| 1 100DOF 11.8 62 0 301DVEW20z |

12| 1 11PP 121 B4 18 3I00DVEW122

E vl

H 4 ¥ W[ Default ) Tree Data JLI | _D_IJ_‘

S

Select destination and press EMTER or choose Pz

9. Decide which type of volume you wish to calculate and add a
heading to the next column on your Tree Data worksheet. For this
simple example we will choose Total Cubic Volume (TotCuVol).

Fd Microsoft Excel - Default.xls H =10l x|
@ File Edit Wew Insert Format Tools Data  Window  Help -8 X
DEHS®R RV FBR-T ov-g=-2 @B 2 & 2
H1 - A TotCuvol
NEE e T EEE G H =
| 1 |Unit | Mum | Label DBH ' HT | Def “olume EquatioTotCuvol —
22 1 PP 12 60 g 300DVEW12Z
3 1 2\PP 116 58 0 300DVEW122
ElN 3 DF 91 #1 5 30IDVEWI0Z |
[ | 4 PP 239 73 15 300DYEW122
] 1 5 PP 123 B5 10 300DVEW122
= I & DF 9 39 15 E0IDVEW: |
5] 1 7 DF 131 B89 16 30IDVEWI0Z |
5| 1 8DF 147 76| 12 30IDVEW20Z | -
10 1 9 PP 19.2) 72 5 300DVEW1ZZ
11| 1 100DF 118 62 0 30IDVEWI0Z |
12 1 11 PP 121 B4 18 300DVEW122
13 ol
M 4 » w]\ Defadlt ) Tree Data 4] | _>_]J_‘
Ready 7

10. Select the cell in the first row of your TotCuVol column and choose
Insert->Function. A dialog will appear: choose the User Defined
category from the drop-down list. All of the available volume
functions will appear in the bottom list. Choose calcTotCubic for this
example.
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Insert Function _____________ 2| x|

Search for a function:

Tvpe a brief description of what vou want to do and then Go |
click 5o

Or select a category: (User Defined j

Select a Function:

calcBdft -
calcCords
calcCordTw

calcMerchiCubic

calcTotCubic{Region,Forest, ¥olEquMum,Dbh, TotalHt)
Zalculakes the botal main sken cubic Foot wolume of a tree,

Help on this function oK I Cancel |

11. A Function Arguments dialog will appear. Enter the arguments as
shown, using cell addresses where appropriate.

Function Arguments E i]l‘
alcTotCubic
Region IS :‘J =
Forest [0 =0
YolEquNum |2 ] = aooovewize
Dbh [D2 El=12
TotalHt [E2| ] =e0
=i
Calculates the total main stem cubic Fook volume of 4 tree,
TotalHt
Formula resulk = 17.2
Help on this function OF I Cancel |

12. Copy the cell containing the function and paste it down the
TotCuVol column.

13. If you wish to calculate Net volumes, create a new column called
NetCuVol. Select the first cell in the new column and hand enter a

formula to calculate the net volume using the cell reference to the
Def value.
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Fd Microsoft Excel - Default.xls =lal =]
@ File Edit “ew Insert Format Tools Data  Window Help -5 X
DEedan Gy tBBR-C - @ -4 |bE 256 2
12 - e =IF(F2=0 H2*(1-(F2/100)) H2)
Al B[ C[DTETF] G | H . |3
1 |Unit  Murm | Label DEH  HT  Def “aolume Equation TotCoaol MNetCubal
Z 1 1 PP 12 BO g 300DVEW122 17.2]  15.8241
3 1 2 PP 1.6 58 0 300DVEW122 156
R 3DF 9.1 41 & 30IDVEW202 | 6.4
(5] 1 4 PP 2389 73 15 300DVEW122 52.8
6| 1 5 PP 123 66 10 300DVEW122 19.9
= K G DF 9 39 15 30IDVEWI0Z | B
8| 1 7 DF 131 B3 16 301DVEW20Z | 212
(o] 1 g DF 147 76 12 301DVEW20Z | 293
EL 9 PP 192 72 5 300DVEW122 527
il 1 10 DF 1.8 B2 0/ 301DVEW202 | 156
E 1 11 PP 121 64 18 300DVEW122 18.7
13 =
H 4 ¥ W[ Default ) Tree Data JLI | _DIJ_‘
Ready )

14. Copy the formula and paste it down the NetCuVol column.

FA Microsoft Excel - Default.xls =10l =]
@ File Edit %iew Insert Format Tools Data  Window  Help R
Deds®| gAY | tB2Ra-F | vo-R=-4 @3 76 7
13 hd e =IF(F3=0H3"(1-(F3/1007) H3)
A[ B[ CTJDTJETJF] G | H . |7
1 |Unit | Mum  Label DBH | HT | Def “olume Eguatior TotCu®ol MetCual —
EI 1 PP 12 B0 8 300DVEW122 17,20 75 824,
3 1 2 PP 1.6 58 0 300DVEW122 126 15.6
ENE 3 DF 91 M 5 30IDVEW202 | 5.4 5.08
ERE 4 PP 2389 73 15 300DVEW122 82.8 70.38
I 5 PP 123 66 10 300DVEW122 19.9 17.91
EAE 6 DF 9 39 15 30IDVEW20Z | 3 A1
E 7 DF 131 B9 16 301DVEW202 | 21.2 17.808
El 8 DF 147 76 12| 301DVEW20z | 233| 25784 =
E 9 PP 192 72 5 300DVEW122 52,7 50.065
I 1 10 DF 11.8 B2 0 301DVEW202 | 156 15.6
% 1 11 PF 121 64 18 300DVEW122 18.7 15.334! .
M 4 » W[ Default  Tree Data 1« | _>]J_‘
Select destination and press ENTER. o choose Pz Sum=239.661 A

Refer to the Volume Estimator Library Excel Functions document for a

complete list and description of available volume functions.
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